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New Internals
The most significant new feature is that the gawk internals
have been completely redone. The parser now builds a linked
list of “instructions”. Each instruction contains a code indicat-
ing what it is and a few members with needed information,
such as the next instruction and which instruction to jump 
to if a jump is needed. This list then is interpreted for each
record by a big switch statement running inside a for loop
that traverses the list. Data for operations are pushed and
popped off a runtime stack.

This implementation performs no worse than the original
recursive evaluator, and in many cases, it performs better. But
what’s really cool is that John added an awk-level debugger!

Since 1978 when awk was first introduced into the world, the
only debugging tool was the print statement. Now, gawk has a
full debugger, with breakpoints, watchpoints, stepping by state-
ment or instruction, the ability to step into and out of functions,
and many other features.

The debugger is a separately compiled program named
dgawk. It is a line-oriented debugger modeled after GDB (the
GNU Debugger). If you’re familiar with GDB, it will be very easy
to learn the gawk debugger. In addition, the debugger is fully
documented in the gawk.texi file in the gawk distribution.

New Language-Level Features
At the language level, there are several new features.

1. gawk now provides a built-in file inclusion mechanism.
Lines that begin with @include and have a filename in double
quotes cause gawk to include that file, using the same path
searching mechanism as the -f option. Nested includes are
supported, and gawk will not include the same file twice. This
effectively obsoletes the igawk script that has come with
gawk for many years.

2. New patterns named BEGINFILE and ENDFILE provide
“hooks” into gawk’s automatic “read a record and process it”
loop. The action for BEGINFILE is called before the first record
is read from each input file. Normally, when a file cannot be
opened, gawk exits with a fatal error (such as if you provide 
a directory on the command line). When a program has a
BEGINFILE pattern, instead, gawk sets the ERRNO variable to a
string indicating the problem, so that you can tell if the file is
problematic. If it is, use the nextfile keyword to just skip it.
ENDFILE actions let you do easy per-file cleanup actions.

3. You now can call a function indirectly. By setting a variable
to the name of the function you wish to call and using special
syntax, gawk will “indirect” through the variable and call the
desired function:

function f1(a, b) { .... }

function f2(c, d) { .... }

{ fun = "f1";    @fun(2, 3)    # calls f1()

fun = "f2";    @fun(4, 5) }  # calls f2()

4. gawk now sports true multidimensional arrays! Regular
awk simulates multidimensional arrays (a[x, y]) using string
concatenation of the index values. gawk now provides 

multidimensional arrays (a[x][y]) but does not require that
arrays be rectangular (as in C or other compiled languages).
Code like this is valid:

a[1] = 1

a[2][1] = 21

It is up to the programmer to track the type stored at any
given index: scalar or array. Subarrays can be passed to functions,
as long as the function knows what to expect.

5. The switch/case statement is enabled by default. gawk
has had switch/case for a long time, but it had to be enabled
at build time, and the default was not to do so; now it’s
enabled automatically.

6. gawk now supports defining fields based on field content,
instead of based on the separators between fields. A new variable,
FPAT, is used. When you assign a string containing a regular
expression to FPAT, gawk begins splitting fields such that each
field is the text that matched FPAT. (Normal field splitting is based
on the text in between fields matching the regular expression in
FS.) This is useful for many kinds of data where FS-based matching
just doesn’t work.

The new patsplit() built-in function provides access to
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this functionality for strings besides the input record. It is the
analogue of awk’s regular split() function. Additionally,
patsplit() lets you capture the text of the separators
between fields.

7. Standard awk provides only one-way pipelines, either to
or from another process. gawk provides a notation for opening
a two-way pipeline to a co-process. gawk uses the same nota-
tion with special, internally recognized filenames, to provide
TCP/IP communication over sockets. This feature has been
available for a long time.

gawk 4.0 enhances the networking by providing explicit
filenames to indicate IPv4 or IPv6 connections. Filenames are 
of the form /inet4/protocol/local-portt/remote-host/remote-port
or /inet6/protocol/local-port/remote-host/remote-port. Plain
/inet/protocol/local-port/remote-host/remote-port is what gawk
supplied up to now and continues to be supported: it now
means “use the system default”. Most likely, this will continue
to be IPv4 for many years.

8. gawk now provides a short (single-letter) option for
every long option that it has. This finally makes it possible to
use almost every feature from a !# script. It does somewhat
bloat the manual page. (gawk has too many options, but
that’s a different problem; nonetheless, I did remove a few
redundant long options.)

9. Interval expressions now are available by default. An interval
expression is an enhanced regular expression syntax, such as
(foo|bar){2,4}, which matches anywhere from two to four
occurrences of either foo or bar. The part between the curly
braces is the interval expression. POSIX added them to awk
many years ago for compatibility with egrep’s regular expres-
sions. But most awks didn’t implement them. For historical
compatibility, gawk’s default was to disable them, unless 
running in POSIX mode. Today, compatibility with POSIX has
gained enough importance for enough users that interval
expressions now are available by default.

10. Finally, for this release, the code has been reviewed and
cleaned up. gawk now requires a full C 89 environment to com-
pile and run. It will not work with K&R compilers or if _ _STDC_ _
is defined but less than 1. The code for many obsolete and
unsupported systems has been removed completely. This slightly
decreases the size of the distribution, but mainly it reduces
useless clutter in the source. The documentation also has been
reviewed and cleaned up.

Source Code Management
For many years, I was the only one with access to gawk source
while it was being worked on. Circa 2006, I made both the stable
and development versions available via CVS from savannah.gnu.org.
This was a good move; it gave the user community access to all my
bug fixes and to my development code base.

In late 2010, I moved to git. I am expecting greater productivity
from using git and better ease of use for the user community.
And, it’s nice to be using 21st-century tools.

Future Work
Some further interesting development remains to be done.

1. The XMLGawk Project (see Resources) is a fork of gawk

based on 3.1.6 that provides better facilities for loading dynamic
extensions and several very interesting extensions to go with those
features. These should be merged into the main gawk code base
and distribution, respectively.

2. Although gawk has had the ability to load extensions
dynamically for many years, the API has not been stable or easy
to use. I have designed an API for C functions that can be called
from an awk program that is considerably better, but I have not
implemented it yet. This should be done.

3. Currently, the gawk distribution builds three separate
executables: regular gawk, pgawk (for profiling awk programs)
and dgawk for debugging them. The new internals enable the
possibility of making just one executable that could perform
all three functions (based on command-line options). This
should simplify the build process and definitely will reduce 
the total installation “footprint”.

4. The documentation could use further cleanup. Some of the
examples cause the documentation to show its age. (Who uses
dial-up BBS systems anymore?)
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Resources

Gawk Home Page at the FSF:
www.gnu.org/software/gawk

Gawk Project Home Page at Savannah, with Links 
and Instructions for Using Git: savannah.gnu.org/
projects/gawk

Gawk Download Directory: ftp.gnu.org/gnu/gawk

Gawk Documentation:
www.gnu.org/software/gawk/manual

Installation Instructions:
www.gnu.org/software/gawk/manual/html_node/
Installation.html#Installation

Brian Kernighan’s “one true awk”:
www.cs.princeton.edu/~bwk/btl.mirror

The XMLGawk Download Page: 
sourceforge.net/projects/xmlgawk

http://www.linuxjournal.com
http://www.skeeve.com
http://www.gnu.org/software/gawk
http://www.gnu.org/software/gawk/manual
http://www.gnu.org/software/gawk/manual/html_node/Installation.html#Installation
http://www.cs.princeton.edu/~bwk/btl.mirror
http://savannah.gnu.org/projects/gawk
http://savannah.gnu.org/projects/gawk
ftp.gnu.org/gnu/gawk
http://www.gnu.org/software/gawk/manual/html_node/Installation.html#Installation
http://sourceforge.net/projects/xmlgawk
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Rapid application development (RAD) is
a trendy data-processing idea to shorten
application software development time. In
the truest sense, RAD should include user-
friendly development tools and seamless
access between end users and actual
development software. Small-business
users lust for software applications that fit
this description. Commercial tools, like
Microsoft Access and AlphaSoftware, share
great success in the business community.

Both of these applications give small-
business users and IT departments a
simple way to develop applications for
internal use quickly, with little effort. Usually,
a small Web-based application can be creat-
ed in only a day or two. Rapid application
development combined with a treasure
trove of professionally presented training
videos and other learning resources keep
these products in the forefront of technology
and embedded in the business world.

Thus, a product like AlphaSoftware
frequently is the cornerstone tool for small-
business users to deploy Web tools for
on-the-fly needs. Although some of these
homespun software applications are down-
right ugly (from an aesthetic and design
standpoint), nonetheless, they are critical
business tools. In fact, their importance is
so profound that some small businesses
will not even consider a Linux environment
because few tools exist that closely match
the feature set of AlphaSoftware or similar
commercial products.

Certainly, good arguments exist for the
robust programming tools Linux offers.
Ruby gains much attention as a power-
house tool, although Ruby is a “foreign
language” to most small-business owners.
So, traditional open-source tools seem to
lack the absolute simplicity necessary for
acceptance by many business users.
Further, Linux coding tools are largely
unfamiliar, which reduces the pool of 
people who are able to assist businesses
develop new applications. Alternatively,
consider how easy it is to find a local IT
guy who can create an Access database

with full form control in only a few days!
Now, WaveMaker provides a strong

Linux contender, properly positioned to
battle for the interest of the business user.
WaveMaker clearly targets a user audience
with quick Web application development
with a minimal learning curve. The
product is available in both a community
edition and an enhanced beta version
poised for more commercial situations
(wavemaker.com/downloads).

Meet WaveMaker
From a marketing perspective, WaveMaker
is a robust tool for rapid application
development of Web-based applications.
You can peruse the WaveMaker site
(www.wavemaker.com) for complete
details of its promotional position. From a
small-business viewpoint, WaveMaker meets
the needs and requirements for rapid
application development, ease of use
and the ability to work across multiple
platforms—including Linux.

The two editions of WaveMaker appear
separated by the need to integrate with
mainline applications. WaveMaker’s com-
munity edition is limited to single-instance
use, while the full edition enables unlimited
users and interaction with commercial
databases like Oracle, IBM DB2 or Microsoft
SQL Server. Conversely, the community
version supports the use of MySQL,
PostgreSQL or HSQLDB. These two alterna-
tives give small business users enough
options for unique operating environments.

The Challenge
WaveMaker seems well suited to compete
for Linux business-user interest. A tough
sell, most business owners need a real-life
example before they consider open-source
systems. Thus, this article intends to
demonstrate how WaveMaker could
migrate a legacy database from the propri-
etary software world into the community
edition of WaveMaker. This simple test is
only a baseline, but it depicts WaveMaker’s
potential. In short, I show how WaveMaker

can measure up to the tall demands of the
business world and also re-affirm Linux as
a viable choice for daily operations.

The example test here includes a sam-
ple business database originally developed
with AlphaSoftware. The parameters of
this test limit the environment to a small
local Web application with only one table.
It also demonstrates data export in a com-
mon format (comma-separated or Excel)
file and MySQL data import. Plus, MySQL
becomes the platform for the new appli-
cation development. This process looks for
potential issues that may arise when users
cull data from a commercial application.

In summary, the test steps are as follows:

1. Prepare the data in a common format.

2. Install WaveMaker community edition.

3. Use WaveMaker to auto-create a Web
form for data entry and update.

Server and WaveMaker
Preparation
For novice users, WaveMaker’s Web site
fully describes how to prepare your oper-
ating environment to support the tool.
The one key decision point is whether to
use the default HSQLDB database. As part
of installation, WaveMaker includes the
components necessary to use HSQLDB. In
this test, let’s use the popular MySQL as
the database engine for the application.

First, let’s use a Debian distribution to
install MySQL. Let’s also use phpMyAdmin
to assist with database creation and data
manipulation. If you want to follow along,
check your distribution’s instructions to
install MySQL and phpMyAdmin, and make
sure they are running before you continue.
Next, download WaveMaker community
edition and follow the installation
instructions here: dev.wavemaker.com/
wiki/bin/wmdoc_6.3/Install.

Preparation for the Test
After installation, let’s plan a simple data
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WaveMaker: It’s Like...RAD!
Database stuck in Windows? Take RADical action and try WaveMaker Community edition.
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export process to move into the new
environment. My research discovered that
AlphaSoftware includes a nifty export
routine to send the data from its own
database to other formats. I tested the
export process with both text and
Microsoft Excel formats successfully. To
assist WaveMaker with field generation, 
I included field names during export.
With the sample data in Excel format,
use phpMyAdmin through the browser
at http://localhost/phpmyadmin (or similar)
to manage the MySQL experience.

To minimize errors with data import, 
a database and table were created in
advance. In Figure 1, a new database
called “linuxjournal” with a table named
“sheet” already is in place. Next, let’s use
the import tool to populate the new 
“linuxjournal” database. Afterward, examine
the database’s structure to make sure the
primary key value and index are appropriate
for the test environment (Figure 2). In this
example, I avoided foreign keys to minimize
opportunities for errors. WaveMaker
includes functions for database creation;
however, the interface is not as familiar as
phpMyAdmin. Further, using WaveMaker

to build your data
structure is an
advanced topic.
Therefore, the 
simpler approach 
is to stay with
phpMyAdmin.

WaveMaker
Live
I used Linux Mint (a
Debian distribution)
for this test. After
installing
WaveMaker, the
icon for startup 
did not appear on
the desktop or in
the application
menu. To work
around this prob-
lem, navigate to
/opt/{wavemaker
sub-directory}/bin/.
Then, execute
./wavemaker.sh,
and observe the
new WaveMaker
application present-

ed on your desktop as shown in Figure 3.
From here, press Start to begin the pro-
cess, and the default browser opens to the
application’s home screen (Figure 4).

From this point, click Create a New

Figure 1. Once logged in to phpMyAdmin, create a test database called
“linuxjournal”, and import test data with field names.

Figure 2. Verify that the indexes and keys are correct for the imported data.

Figure 3. To the point, WaveMaker responds
with a minimal window allowing you to start
or stop the application.

Figure 4. At first, WaveMaker gives you the
opportunity to create projects, open existing
ones or just work through a tutorial.

http://www.embeddedarm.com
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Project, give it a name, and then
WaveMaker drafts the workspace for the
application within the browser (Figure 5).
This is the primary control center for devel-
opment. While the look and feel may seem
unfamiliar, WaveMaker reduces training
time through intuitive command labels and
software component tree organization.

Establishing Database
Connection
Once WaveMaker is up and running, it
must establish database connectivity to

continue. Next, select
Services and then Database
Services to define the con-
nection to “linuxjournal”.
Now, WaveMaker needs
the right information to
connect to the database
(Figure 6). With MySQL,
the first step is to change
the initial drop-down list
from the default HSQLDB
to MySQL. Next, input the
database userid, password
and exact database name
in the fields provided. Click
Test Connection at the 
bottom of the window to
ensure connection. Once
successful, select Import
to continue the data
import process, and
WaveMaker responds
with the elements of the
MySQL database in a new
window (Figure 7). Stop
here and evaluate your
structure. It’s important to
validate keys and indexes.
Also note the field names
of your data to ensure
they are listed properly.

Application Design
With a predominantly GUI
interface, WaveMaker now
is ready to create a Web-
based application. A pivotal
benefit for the small-
business user, this interface
relies on simple drag and
drop for many operations.
Automatic processes assist
with form creation, data
placement

and manipulation. Plus, error
correction is quite simple and
capitalizes on the familiar
Edit and Undo routine when-
ever you change your mind!

First, click on Canvas and
Palette as shown in Figure 8.
The link to the “linuxjournal”
database previously created
now is available in
WaveMaker’s tree view.
Now, let’s create a 
simple entry and update

application—in one step. With the
mouse, drag the database onto the blank
area of the working screen. WaveMaker
automagically populates the working area
of the Canvas with the sample data from
“linuxjournal”. It’s remarkable to watch
WaveMaker create editable (bold) fields
for the data on the bottom of the Canvas.
Figure 9 shows the results.

In essence, data from the MySQL table
is displayed on top, and a detail section
(with editable fields) is created below. At
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Figure 5. A clean slate or “Palette” is the home screen 
of WaveMaker.

Figure 6. WaveMaker’s Template to Establish Database Connectivity

Figure 7. After import, your database structure is displayed.
Figure 8. Navigating to the Location of Your
Imported Table (Called “Sheet”)

Figure 9. After drag and drop, WaveMaker creates the list of
data on the top of the screen, and the editable fields are listed
below. Red text was added by the author.

http://www.linuxjournal.com
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the same instant, WaveMaker creates three
buttons for data manipulation: New, Update
and Delete (Figure 10). The current view
displays the skeleton of the application,
complete and test-ready. Select Test from
the top window, and a new browser win-
dow with the application displays in test
mode. Choose Run, and WaveMaker saves
and then runs the application in a new
browser window, as shown in Figure 11.

Now, work with this mini-program to
verify the success of the transition, exit the
application and then re-visit phpMyAdmin
to see the elements properly added,
changed and deleted.

Pinch Yourself
WaveMaker just completed this test
migration in approximately 15–20 
minutes! Certainly more complex data
migrations will require a concerted
effort to ensure proper foreign keys 
and precise index setup. Yet, the viability 
of this principle is proven for a small
application migration.

In this test, WaveMaker performs quite
well. Building the application and running
it on the same machine is a bit sluggish,
but this will change substantially with
respect to hardware specifications and
overall configuration.

No Parking!
This test purposely excluded necessary
elements to make many applications
really suitable for business. Nevertheless,

adding buttons, screens and tabs is very
straightforward. For example, user login
logos and multiple tabbed displays
often are staples of even the most 
rudimentary business applications.
WaveMaker includes many nicely packaged
tools that enable users to drag and drop
additional features immediately into the
live Palette.

WaveMaker builds these other
essential elements with a host of 
“widgets” along the application’s left
panel (Figure 12). Users take advantage
of this noncode environment and simply
drag and drop new features into the
Palette. For example, a handy calendar
(Figure 13) or simple page navigation
(Figure 14) require no direct code. Plus,
login security and roles are handled 
efficiently in the Services and Security
tabs of the application—once again, a
simple user interface.

The Takeaway
For business users, WaveMaker excites
the potential of open-source possibili-
ties. In recent years, the strongholds of
proprietary operating systems usually
included finance and point of sale.
Because few comparable business-class
applications exist, the impetus to move
into the open-source world is sometimes
difficult. It’s also clear that mainstream
business users may consider Linux when
the core applications of their business
can be migrated with ease.

Often overlooked, small database
development served as a type of 
commercial software lynchpin. Thus,
business operators are often locked 
in the proprietary realm. As a former
AlphaSoftware user, I too see the
impediments to change. Plus, applica-
tions like AlphaSoftware give developers

a standardized
tool to develop
and deploy exe-
cutable software
in addition to
Web applications.
This is a market
segment not
directly 
marketed by
WaveMaker. As
with most soft-
ware, familiarity

of interface and technical support are
all weighty factors in the decision.

WaveMaker seems like a bold step
and immediately gathers the attention of
business users. It is a true competitor to
the commercial Web application develop-
ment world and deserves attention by the
business community. VMware’s recently
announced acquisition of WaveMaker
(dev.wavemaker.com/blog/2011/03/08/
wavemaker-springs-to-vmware) gives
this application a boost in recognition and
in business users’ confidence in its future
stability. Go give WaveMaker a try!�

Don Emmack, a Change Management consultant, assists
government and business users with infrastructure and
operational issues. A former Sr. Vice President for an
international consulting firm, his work includes domestic
and international clientele. Don is an early adopter of 
new technology, yet remains hopelessly addicted to his
1980s-era fax machine!

Figure 10. In the bottom right, WaveMaker
automatically provides New, Update and
Delete buttons for the application.

Figure 12. A Sample of Widgets Included
with WaveMaker

Figure 13. The Included Calendar Widget

Figure 14. Simple Creation of Data Navigation
Buttons

Figure 11. Live Operation of the Sample Data Migration in Less 
Than 20 Minutes

http://www.linuxjournal.com
http://dev.wavemaker.com/blog/2011/03/08/wavemaker-springs-to-vmware
http://dev.wavemaker.com/blog/2011/03/08/wavemaker-springs-to-vmware


jEdit is a cross-platform text editor written in Java. The current stable
version at time of this writing is 4.3.2, and it’s available at jedit.org.
Besides the cross-platform capabilities, jEdit offers other features,
such as a sophisticated plugin system, syntax highlighting for 130
languages, a built-in macro language and extensive encoding sup-
port. I wrote this article using jEdit, and I demonstrate some of its
features here, especially some of the plugins I have found useful.

Before I start, jEdit is a GUI text editor of some heft. It is not a
replacement for using vi on the command line to edit a configuration
file on a remote server. It does serve well in handling many files simul-
taneously with visual feedback and with the benefits of a GUI inter-
face. To put it another way, I use vi or jEdit depending on the need.

Installation is fairly easy; just go to the download page and grab
the installer jar. Be sure to check out the compatibility link if you
have a non-Sun (Oracle) or Apple version of Java. From personal
experience, I have not had success running jEdit on gcj. Assuming
you have a compatible version of Java, use the following to install:

java -jar jedit4.3.2install.jar

This launches an installer program that guides you through the
process. For the sake of reference, jEdit keeps its configuration files,
on Linux anyway, in ~/.jedit/. I mention this because I keep that
directory synced between my laptop and my desktop machines. As
a result, I have a consistent working environment between the two.

At its heart, jEdit is a just a text editor, although it’s a text edi-
tor with a lot of options. You can make these options global or
apply them on a per-buffer basis. You can reach the options via
the Utilities menu item. The global options stick between editing
sessions, but the buffer options do not, unless you use the buffer-
local method. This consists of embedding colon-separated hints to
jEdit in the file. jEdit checks the first or last ten lines for these
hints. As an example, to specify an indentation of 2, use spaces
for tabs and “hard” wrap, the embedded hints would be:

:identSize=2:noTabs=True:wrap=hard:

jEdit checks anywhere in those lines, so you can place the
hints behind comment symbols.

Also note that jEdit supports mode-specific settings, where a
mode is a file type, such as Python (*.py), C (*.c), HTML (*.html) and
so on. The various modes come with default settings, but they can
be overridden. One of the key benefits is that the mode system pulls
in file-type-specific syntax highlighting. Other options are available
for the editor’s layout. As you can see in the screenshots for this article, 
I tend to run jEdit with two buffers open, split vertically and with
line-numbering enabled. The ability to look at the beginning and end
of file at the same time, especially source code, is invaluable.

You can use jEdit in a great number of ways. Watching me
enter text, although it has its moments, is not terribly inspiring.
So to keep things interesting, here I demonstrate some of the

plugins I have found useful. Plugins are code that scratches an
itch. The base jEdit program does a lot, but it does not cover the
universe that is text editing, or other chores for that matter.

jEdit has a macro system (not covered in this article), so you
can whip up your own solutions to problems or scope out the
plugins available and not re-invent the wheel. So, before getting
into the plugins themselves, here’s an overlook at the plugin system
itself. They can be found at plugins.jedit.org or via the Plugins
item on the menu bar. Click on the Plugin Manager item and then
the Install tab for a list of available plugins. Clicking on an item
shows a description at the bottom of the page. Check the box of
any plugin(s) you want to install, and then click Install. If the plugin
has dependencies, they also will be installed.

So, where to start with the plugins? Let’s go from less-involved
to more-involved, beginning with one suggested to me by a
member of the Bellingham Linux User Group: WhiteSpace. It does
what it says—tracks whitespace. I have it set up to show trailing
whitespace and, additionally, to eliminate any such whitespace
when I save. I also have it show tabs and modify them according
to my jEdit soft tab setting. This setting, when enabled, converts
tabs into a defined number of spaces. WhiteSpace uses the setting
to convert preexisting tabs into spaces or vice versa. All of the
above helps when I work in Python code, keeping that pesky
whitespace in order. This also is valuable when writing for Linux
Journal, which requires that writers use spaces not tabs. See
Figure 1 for WhiteSpace in action on a Python file. From the
screenshot, you can see one way to set it up. The other way is
to go to Plugins→Plugin Options→WhiteSpace. This is how
most of the plugins work, although you will find there often
are differences in options available between the two locations.

Another plugin I use quite often is JDiff. As the name implies,
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Figure 1. WhiteSpace Plugin Settings and at Work
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it shows the diff between files. Of course, you could use the
command line to do the same thing. The benefit of the plugin
is the graphical presentation it provides. Figure 2 shows the
dual-diff mode using this article as the files. From here, you
can create a diff output. You also can walk through the diffs
and apply them from one side to another.

The JDiff plugin has a dockable component that allows you to
drill down into the lines of the files for differences (Figure 3). In the
dual-diff screenshot (Figure 2), you can see another plugin at work,
VoxSpell. The underlining is the spell-checker at work. If you look at
the file, you can see that plugin/plugins go from being underlined
to not underlined. I right-clicked on the words and added them to
the dictionary as acceptable, at least for the purposes of this article.
Note that VoxSpell has a dependency on the Spell Check plugin. It
also uses quite a bit of memory, so that may be an issue.

Next is a chicken-and-egg problem. I ran across a reference to
the SQL plugin for jEdit. In the course of installing it, I found it

Figure 3. JDiff Dockable Showing Line Differences

Figure 2. JDiff Plugin in Dual-Diff Mode

Advertiser Index

ATTENTION ADVERTISERS

December 2011 Issue #212 Deadlines
Space Close: September 26; Material Close: October 4

Theme: Readers’ Choice

BONUS DISTRIBUTIONS:
ApacheCon, USENIX LISA, SuperComputing

Contact Joseph Krack, +1-713-344-1956 ext. 118,
joseph@linuxjournal.com

Advertiser          URL                            Page #

CHECK OUT OUR BUYER'S GUIDE ON-LINE. 
Go to www.linuxjournal.com/buyersguide where you can learn
more about our advertisers or link directly to their Web sites.

Thank you as always for supporting our advertisers by buying
their products!

1&1 INTERNET, INC. www.oneandone.com 1

ABERDEEN, LLC www.aberdeeninc.com C3

ARCHIE MCPHEE www.mcphee.com 79

BZ MEDIA www.hackerhalted.com/2011 49

CPANEL www.bootcamp.cpanel.net 59

DEBIAN CONFERENCE debconf11.debconf.org 69

DIGI-KEY CORPORATION www.digi-key.com 79

EMAC, INC. www.emacinc.com 39

EMPERORLINUX www.emperorlinux.com 47

FUDUNTU www.fuduntu.org 79

GENSTOR SYSTEMS, INC. www.genstor.com 25

IXSYSTEMS, INC. www.ixsystems.com C2, 3

LINODE, LLC www.linode.com 33

LINUX JOURNAL STORE www.linuxjournalstore.com 75

LOGIC SUPPLY, INC. www.logicsupply.com 31, 57

LULLABOT doitwithdrupal.com 12, 13

MICROWAY, INC. www.microway.com C4, 5

MIKRO TIK www.routerboard.com 7

RACKMOUNTPRO www.rackmountpro.com 23

RENDEK ONLINE MEDIA linuxcareer.com 9

SAINT ARNOLD BREWING COMPANY www.saintarnold.com 79

SILICON MECHANICS www.siliconmechanics.com 18, 19, 43

SOFTWARE FREEDOM INTERNATIONAL www.softwarefreedomday.org 55

TECHNOLOGIC SYSTEMS www.embeddedx86.com 61

USENIX ASSOCIATION www.usenix.org/lisa11/lj 67

www. l inux journa l .com september 2011 | 6 5

http://www.linuxjournal.com/buyersguide
http://www.oneandone.com
http://www.aberdeeninc.com
http://www.mcphee.com
http://www.hackerhalted.com/2011
http://www.bootcamp.cpanel.net
http://www.digi-key.com
http://www.emacinc.com
http://www.emperorlinux.com
http://www.fuduntu.org
http://www.genstor.com
http://www.ixsystems.com
http://www.linode.com
http://www.linuxjournalstore.com
http://www.logicsupply.com
http://www.microway.com
http://www.routerboard.com
http://www.rackmountpro.com
http://www.saintarnold.com
http://www.siliconmechanics.com
http://www.softwarefreedomday.org
http://www.embeddedx86.com
http://www.usenix.org/lisa11/lj
mailto:joseph@linuxjournal.com
http://www.linuxjournal.com
http://debconf11.debconf.org
http://doitwithdrupal.com
http://linuxcareer.com
http://debconf11.debconf.org


6 6 | september 2011 www.l inux journa l .com

had a dependency on the Project Viewer plugin, which meant I
had to learn how to use Project Viewer in order to use the SQL
plugin. It turns out that was a good thing. In fact, this article
was written using Project Viewer. First, I will cover the SQL plugin
and later expand on the Project Viewer plugin.

SQL allows you to work with SQL databases from within the
editor. Setting things up to use the plugin is a two-step process.
First, you need to do the general setup in the SQL options dialog.
Go to the menu, then Plugins→Plugins Options→SQL. Go to
the JDBC page and use the Add Element button to indicate the
path(s) to the JDBC drivers you want to make known to the
program. At the time of this writing, SQL can work with Oracle,
MySQL, PostgreSQL, Firebird, DB2, Progress, MS SQL Server 2000,
Sybase and Teradata, assuming you have the requisite JDBC
drivers. This previous step “registers” the database so it can be
used in the next step.

The next step is to configure a specific database (or maybe
more than one) with a project. This is where Project Viewer
comes in. You use it to create the project (more detail on that
later). For now, I will use the project that is this article. From the
project pane, right-click on the project name and select proper-
ties. This will lead to a series of dialogs that allow you to fill in
the needed information (Figure 4). In this case, I am using the

Pagila demo database for Postgres. From a jEdit buffer, you now
have access to the database (Figure 5). There is quite a bit going
on there, so let’s take it a step at a time.

Just above the buffers is the SQL toolbar. First, above the
left buffer is a Database: drop-down list with the previously
configured database selected. To the right of that are four
buttons: the first is Execute selection, the second is Execute
buffer, the third is Load object, and the last is Repeat last
query. To the right of the last button is the Preprocessors drop-
down. For this example, I am using the Variable substitution
preprocessor. This can be seen in the “actor_id > ?” expres-
sion in the SQL statement in the right buffer. (As a side note,
notice the SQL syntax highlighting prompted by the use of the
*.sql extension.) To continue, I have selected the statement I
want to run and then clicked the Execute selection button.
Because I have variable substitution in force, an input box was
presented (not shown) for me to enter the value for actor_id,
in this case 35. The result is presented in a separate window.
From the result set, it is possible to save the data as CSV or
tab format or as INSERT statements. You also can show/hide
columns. Additionally, it’s possible to run multiple statements
at once (Figure 6). This is a somewhat contrived example, but
it does show what’s possible. The previous feature allows me

INDEPTH

Figure 4. Adding SQL Server to a Project

Figure 7. SqlVFS, Database as a Filesystem

Figure 6. SQL Plugin Running Multiple Statements

Figure 5. SQL Plugin Returning a Result Set
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to create database DDL files and run them from within 
the editor.

The last feature is SqlVFS (Sql Virtual File System). This
allows you to browse the selected database as a filesystem. 
To get there, go to File→Open→Commands→Plugins→Show
databases. Figure 7 shows what you get. Note that although
Data says 0 bytes, double-clicking on it gives a result set from
the table.

Project Viewer is a plugin to make handling a group of
related files (a project) easier. For demonstration purposes, 
I’m using the files that make up this article. Project Viewer
creates a docked button below the menu bar. Click it, and 
a drop-down appears with All Projects listed. Click this, 
and a window opens. Right-click on All Projects, and select
Add project, and you get another window (Figure 8) to enter
the required information. Click OK to create the project.
Project Viewer then takes you to that project and puts up 
a prompt about importing files into the project. By default, 
it imports everything below the root directory.

At this point, the group of files is bound together as a 
project. The benefit is that Project Viewer keeps track of their
state and allows you to return to that state at a later time.
Note that it’s possible to add other directories/files to the 
project later. Simply right-click on the project name, select
Add files and navigate to the desired location(s). You can 
add new files from the existing directory in two ways: one 
is manual and the other automatic. The manual option is to
right-click the project name and select Re-import files. The
automatic option is to open the project name context menu,
select Properties→Auto Reimport and enable it with a time
parameter. Figure 9 shows the visual indicators as to the status
of files, where underlining represents open files and color 
indicates type of files.

One really handy feature is the Compact View of a project.
This is enabled in the General Options of the Project Viewer
plugin options. It presents a flattened view of a directory

structure. This article does not really have the directory depth
to illustrate the benefit, so take a look at a screenshot from
another project (Figure 10). Each line takes you directly to a
directory. Also of note is the Working Files tab in the project
window. This groups all your current open files together,
which is handy in a large project.

Some other features include archiving the project files in 
a JAR file and searching in the project or project subdirectory
files for a string. The ability to consolidate all of the files related
to a project in a single interface is something I’ve come to
appreciate even more as time passes. Walking through a
Project Viewer directory tree renaming/moving/deleting files
while looking at the actual files is priceless.

What I have presented above barely scratches the surface
of what is possible with jEdit. It has a macro facility that I have
not even started to explore. The most important part of jEdit,
to me, is that it lets me get work done without getting in my
way. Furthermore, it makes that work easier, and I hope you
find it useful also.�

Adrian Klaver works with computers, and when that proves frustrating, he pushes wheelbarrows
of heavy stuff around to remind himself that maybe computers are not so bad after all.

Figure 8. Setting Up a Project Using Project Viewer Figure 9. Files in Project Viewer

Figure 10. Project Viewer Compact View
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Perl has been around for more than 20 years. During that time, 
it has received its share of both praise and criticism, and lots of
misconceptions surround it. Much of this stems from long-outdated
notions of what Perl used to be, but have nothing to do with
what Perl actually is today.

Perl hasn’t been standing still. It’s been growing continuously
and evolving, and that growth has accelerated dramatically in the
past few years. Moose is one of the technologies at the heart of
this “Perl Renaissance”, which also includes other exciting projects
that have emerged, such as Catalyst and DBIx::Class.

Moose is essentially a language extension for Perl 5 that
provides a modern, elegant, fully featured object system. I say
“language extension”, but Moose is written in pure Perl, and as
you’ll see, its syntax is still normal Perl. You don’t need to patch
Perl itself to use Moose; under the hood, it’s just Perl 5.

Because Moose is still just Perl 5, it’s fully compatible with all
of those wonderful modules on CPAN, regardless of whether they
are written in Moose (and most aren’t, as CPAN has been around
for so long, and Moose is relatively new).

For me, this is still the single biggest reason to choose Perl.
Whatever you are trying to accomplish, chances are, there already
is a refined module for it on CPAN. This usually means dramatic
cuts in total development time, because someone else already has
written a lot of your program for you.

And now, with all the modern object-oriented features Moose
brings to Perl, you get to have your cake and eat it too.

In this article, I provide an introduction to object-oriented
programming in Moose and cover some of Moose’s core features
with useful examples. To get the most out of this article, you
already should be familiar with object-oriented programming
concepts, such as classes, objects, methods, attributes, con-
struction and inheritance.

You also need to know Perl—at least the fundamentals. If you
don’t know Perl, learning it is not very hard to do. At the end of
the day, it’s just syntax. The good news is you don’t need to
master Perl by any stretch to start using Moose.

Perl does have its quirks, and Moose doesn’t make them all
totally go away (and you wouldn’t want them all to go away,
because a lot of them are really useful). The most important
concepts to understand are how Perl references work (the

“perlreftut” tutorial is a great place to start—see Resources), and
also the basics of working with Scalars, Arrays and Hashes. Also,
learn what the fat comma is (=>) if you aren’t already familiar
with it. Moose makes heavy use of it as an idiom. It’s actually not
that scary; it’s interchangeable with the normal comma (,).

Most of the rest of it you can learn as you go. Normal language
stuff like loops, conditionals and operators aren’t all that different
in Perl than any other language. So give it a shot. I think you’ll
find it’s well worth the investment.

Getting Moose
Chances are you already have a distribution of Perl installed on
your system. You at least should have Perl 5.8, but preferably 5.10
or 5.12. Installing Moose from CPAN is an easy task; simply run
the following command:

cpan Moose

This should download and install Moose for you, as well as all
of Moose’s dependencies.

Object-Oriented Perl (the Old Way)
Even though Perl has had object-oriented features for a long time,
it was not originally designed—syntactically—as an object-oriented
language. This is more about the API provided to the programmer
than it is about the underlying technical design of Perl itself.

Perl 5 provides a lean environment with the fundamental
features and hooks needed for object-oriented programming,
but then leaves most of the details (such as setting up object
constructors, implementing attributes and handling validation)
to you. As a result, the “right way” to go about implementing
these concepts is open to interpretation.

The fundamental feature utilized by Perl to support objects is
the “blessed” reference. This is like the flux capacitor of objects in
Perl. Blessing simply associates a normal reference (usually a Hash
reference) with a class. The blessed reference then becomes the
“object instance”, and its referent is used as the container to store
the object’s data.

The class name is the same thing as the package name, which
is nothing more than the namespace in which subroutines and
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variables are defined. The subroutines defined in the given
package namespace become the methods of the class and 
can be called on the object reference.

All object-oriented languages have to do something along
these lines to implement objects under the hood. Other languages
just don’t impose so many of the low-level details on the programmer
as in pure Perl.

Here is an example of a simple class in old-school Perl 5 OO:

package MyApp::Rifle;

use strict;

sub new {

my ($class, %opts) = @_;

$opts{rounds} = 0 unless ($opts{rounds});

my $self = bless( {}, $class );

$self->rounds($opts{rounds});

return $self;

}

sub rounds {

my ($self, $rounds) = @_;

$self->{_rounds} = $rounds if (defined $rounds);

return $self->{_rounds};

}

sub fire {

my $self = shift;

die "out of ammo!" unless ($self->rounds > 0);

print "bang!\n";

$self->rounds( $self->rounds - 1 );

}

1;

Save the above class definition into a file named MyApp/Rifle.pm
within one of your Perl’s include directories, and then you can use
it in a Perl program like this:

use MyApp::Rifle;

use strict;

my $rifle = MyApp::Rifle->new( rounds => 5 );

print "There are " . $rifle->rounds . " rounds in the rifle\n";

$rifle->fire;

print "Now there are " . $rifle->rounds . " rounds in the rifle\n";

Moose Sugar
Moose is really nothing more than syntactic “sugar” that auto-
matically takes care of the boiler-plate tedium and low-level details
of implementing objects automatically. This is possible because of
Perl’s powerful introspection capabilities—Moose dynamically
manipulates the class definition at compile time just as if it had
been written that way.

The previous class could be implemented like this with Moose:

package MyApp::Rifle;

use Moose;

has 'rounds' => ( is => 'rw', isa => 'Int', default => 0 );

sub fire {

my $self = shift;

die "out of ammo!" unless ($self->rounds > 0);

print "bang!\n";

$self->rounds( $self->rounds - 1 );

}

1;

Not only is this code much shorter, cleaner and easier to read,
but it is doing all the things the non-Moose class was doing and
more. First, Moose is automatically creating the “new” constructor
method behind the scenes. It is also automatically setting up
“rounds” as an attribute (aka object variable), which Moose
understands as a distinct concept.

Pure Perl has no such understanding; if you want “attributes”,
you have to implement them yourself by writing accessor methods
by hand and deciding how they should work (the non-Moose 
version above illustrates only one of many possible approaches).

Moose, on the other hand, provides a refined, fully integrated
object attribute paradigm. It sets up the accessor methods, handles
the data storage and retrieval, and automatically configures
the constructor to initialize attributes optionally with supplied
parameters—and that is just scratching the surface!

One of the problems with the non-Moose version of our class
is that there is no validation for “rounds”. For example, nothing
stops us from doing this:

my $rifle = MyApp::Rifle->new( rounds => 'foo' );

This is one of the areas where Moose really shines; it provides
a complete Type system that is very straightforward to use. In the
Moose version, the option isa => 'Int' sets up the rounds
attribute with a type constraint that automatically will throw an
exception (with a meaningful message) if you try to set the value
to anything that is not a valid integer. This would stop you from
setting rounds to 'foo' because it’s not an integer, it’s a string.

This illustrates an important point about Moose’s design and
approach. Its syntax is declarative rather than imperative. This
means you just need to specify what you want it to do instead of
how it needs to do it. This is in sharp contrast to the traditional
Perl 5 OO style, where that is exactly what you would have to

Moose is really nothing more than
syntactic “sugar” that automatically
takes care of the boiler-plate tedium
and low-level details of implementing
objects automatically.
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do—add additional lines of code in the accessor method to test
the value for validity and handle the result.

The syntax isa => 'Int' doesn’t provide any insight on
how Moose will go about checking and enforcing the type
constraint. And that’s the whole point—you don’t care. But,
you can rest assured it will do it in a far more thorough and
robust manner than anything you’d want to waste time on
doing yourself.

More about Attributes
You declare attributes in Moose with the “has” function. This
consists of a unique attribute name, followed by a list of named
options (key/values). Although it looks and behaves like a built-in
language keyword, it is really just a function call. Its documented
syntax is just idiomatic for the purpose of code readability (it’s a
fancy way to pass an argument list).

Moose provides all sorts of options that define the behavior of
a given attribute, including setup of accessors, data types, initial-
ization and event hooks. The simplest attribute is just an object
variable that is set up as either read-write (rw) or read-only (ro)
with the “is” option:

has 'first_name' => ( is => 'rw' );

The is option tells Moose to set up the accessor method,
which is what you use to get and set the attribute’s value. You
set the value of an attribute by passing a single argument to
the accessor (such as $obj->first_name('Fred')), and you
get the current value by calling the accessor with no arguments
($obj->first_name). Setting the value is only allowed if the
attribute “is” => “rw”. If it’s “ro”, and you try to set its value
through the accessor an exception will be thrown.

This is the core of the attribute paradigm, but lots of other options
provide useful features. Here are a few of the noteworthy ones:

� is: ro or rw, creates either a read-only or read-write 
accessor method.

� isa: string representing an optional type constraint.

� default: the default value of the attribute.

� builder: alternative to default—name of a method that will
generate the default.

� lazy: if true, the attribute is not initialized until it’s used.

� required: if true, attribute value must be provided to 
constructor or have default/builder.

The builder option lets you specify a method to use to popu-
late the attribute’s default value. A builder is a normal method
defined within the class, and its return value is used to set the
attribute’s initial value. If the builder needs to access other
attributes within the object, the attribute must be lazy (to 
prevent it from potentially being populated before the other
attributes it depends on).

Because this is such a common scenario, for convenience,
Moose provides the “lazy_build” attribute option that automatically
sets the lazy option and sets the builder to _build_name (such
as _build_first_name for an attribute named first_name).
For example:

has 'first_name' => ( is => 'ro', lazy_build => 1 );

sub _build_first_name {

my $self = shift;

return $self->some_lookup('some data');

}

Attributes Containing Objects
So far, I’ve talked only about attributes containing simple scalars.
Attributes can contain other types of values as well, including
references and other objects. For example, you could add a
DateTime attribute to your MyApp::Rifle class to keep track of
the last time “fire” was called:

package MyApp::Rifle;

use Moose;

use DateTime;

has 'rounds' => ( is => 'rw', isa => 'Int', default => 0 );

has 'fired_dt' => ( is => 'rw', isa => 'DateTime' );

sub fire {

my $self = shift;

die "out of ammo!" unless ($self->rounds > 0);

my $dt = DateTime->now( time_zone => 'local' );

$self->fired_dt($dt);

print "bang!\n";

print "fired at " . $self->fired_dt->datetime . "\n";

$self->rounds( $self->rounds - 1 );

}

1;

This is fairly straightforward. I’m creating a new DateTime
object and storing it in my fired_dt attribute. Then, I can call
methods on this object, such as the datetime method, which
returns a friendly string representing the date and time.

Delegations
Alternatively, you could utilize Moose’s delegation feature when
you set up the fired_dt attribute, like this:

has 'fired_dt' => ( 

is => 'rw', 

isa => 'DateTime',

handles => {

last_fired => 'datetime'

}

);

INDEPTH
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This will set up another accessor method named last_fired and
map it to the datetime method of the attribute. This makes the
invocations of $self->last_fired and $self->fired_dt->datetime
equivalent. This is worthwhile because it allows you to keep your
API simpler.

Types
Moose provides its own type system for enforcing constraints on
the value to which an attribute can be set. As I mentioned earlier,
type constraints are set with the isa attribute option.

Moose provides a built-in hierarchy of named types for general-
purpose use. For example, Int is a subtype of Num, and Num is a
subtype of Str. The value 'foo' would pass Str but not Num or Int;
3.4 would pass Str and Num but not Int, and 7 would pass all of
Str, Num and Int.

There also are certain built-in types that can be “parameterized”,
such as ArrayRef (a reference to an array). This lets you not only
require an attribute to contain an ArrayRef, but also set type
constraints on the values that ArrayRef can contain. For example,
setting isa => 'ArrayRef[Int]' requires an ArrayRef of
Ints. These can be nested multiple levels deep, such as
'ArrayRef[HashRef[Str]]' and so on.

Another special parameterized type is Maybe, which allows a
value to be undef. For example, 'Maybe[Num]' means the value is
either undef or a Num.

You also can use type “unions”. For example, 'Bool | Ref'
means either Bool or Ref.

If the built-in types aren’t sufficient for your needs, you can
define your own subtypes to do any kind of custom validation you
want. The Moose::Util::TypeConstraints documentation provides
details on creating subtypes, as well as a complete listing of the
built-in types that are available (see Resources).

Finally, instead of specifying the name of a defined type, you
can specify a class name, which will require an object of that class
type (such as in our DateTime attribute example). All of these
concepts can be intermixed for maximum flexibility. So, for example,
if you set isa => 'ArrayRef[MyApp::Rifle]', it would require
an ArrayRef of MyApp::Rifle objects.

Inheritance
Subclassing is relatively painless in Moose. Use the extends
function to make a class a subclass of another. The subclass
inherits all the parent’s methods and attributes, and then 
you can define new ones or override existing ones simply by
defining them again.

Moose also provides helpful attribute inheritance sugar that
allows you to inherit an attribute from the parent, but override
specific options in the subclass. To tell Moose to do this, prepend
the attribute name with a plus sign (+) in a “has” declaration in
the subclass. (Note: attribute options related to accessor method
names cannot be changed using this technique.)

For example, you could create a new class named
MyApp::AutomaticRifle that inherits from the MyApp::Rifle class
from the previous example:

package MyApp::AutomaticRifle;

use Moose;

extends 'MyApp::Rifle';

has '+rounds' => ( default => 50 );

has 'last_burst_num' => ( is => 'rw', isa => 'Int' );

sub burst_fire {

my ($self, $num) = @_;

$self->last_burst_num($num);

for (my $i=0; $i<$num; $i++) {

$self->fire;

}

}

1;

Here, MyApp::AutomaticRifle can do everything MyApp::Rifle
can do, but it also can “burst_fire”. Also, the default of the
rounds attribute has been changed to 50 in AutomaticRifle, but
the rest of the options for the rounds attribute still are inherited
from the parent Rifle class.

You might use MyApp::AutomaticRifle like this:

use strict;

use MyApp::AutomaticRifle;

my $rifle = MyApp::AutomaticRifle->new;

print "There are " . $rifle->rounds . " rounds in the rifle\n";

$rifle->burst_fire(35);

print "Now there are " . $rifle->rounds . " rounds in the rifle\n";

The BUILD Method
Although Moose automatically sets up the “new” constructor for
you, there still are times when you need to execute custom code
at construction. If you need to do that, define a method named
BUILD, and it will be called immediately after the object has been
constructed. Don’t create a “new” method; that will interfere with
Moose’s operation.

BUILD is also special as it relates to inheritance. Unlike 
normal methods that override the parents’ methods when
redefined in subclasses, BUILD can be defined in every class 
in the inheritance tree and every one will be called, in order
from parent to child.

Roles
Roles define some set of behaviors (attributes and methods) without
being full-blown classes themselves (capable of instantiation
as objects directly). Instead, Roles are “composed” into other
classes, applying the defined behaviors to those classes. Roles
are conceptually similar to “mixins” in Ruby.

Roles also can require that consuming classes have certain
methods by calling the “requires” sugar function in the Role
definition (or throw an exception).

You call the “with” sugar function to consume a Role by
name, just like you call “extends” to inherit from a regular class.

Here is an example of a simple Role that could be composed
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into either MyApp::Rifle or MyApp::AutomaticRifle:

package MyApp::FireAll;

use strict;

use Moose::Role;

requires 'fire', 'rounds';

sub fire_all {

my $self = shift;

$self->fire while($self->rounds > 0);

}

1;

You would then add this single line to MyApp::Rifle or
MyApp::AutomaticRifle to give either class the fire_all method:

with 'MyApp::FireAll';

In the case of MyApp::AutomaticRifle, the with statement
must be called after the extends statement, because the “fire”
and “rounds” methods don’t exist within MyApp::AutomaticRifle
before that, and the Role’s requires statements would fail.

If you add the Role to MyApp::Rifle, it will be inherited by
MyApp::AutomaticRifle automatically, so there would be no need
to add it there also (although it won’t break anything if you do).

Method Modifiers
Method modifiers are one of the more powerful and flexible
features of Moose. The most common types of modifiers are
before, after and around. Before and after are really just
“hooks” to execute some code whenever a given method is
called, either before or after, as the names imply. For example,
this would print a string every time fire_all is called:

before 'fire_all' => sub {

my $self = shift;

print "Say hello to my little friend!\n";

};

The “around” modifier is quite a bit more powerful than
before and after because it actually can change the arguments

passed to, and the data returned from, the original method. 
It also can programmatically decide whether even to call the
original method at all.

Around modifiers actually replace the original method, but get
passed the original method and arguments to be able to call it
within the new modifier function, but unlike before and after, this
has to be done manually in around. The basic blueprint of this is
below, which is an example of an around modifier that exactly
reproduces the original method (having no observable effect):

around 'fire_all' => sub {

my ($orig, $self, @args) = @_;

return $self->$orig(@args);

};

In an around modifier, the first argument is the method ($orig)
instead of the object reference ($self) like in normal methods.
Then, it’s up to you to call the original method ($self->$orig)
and capture its return value (or not) and then return.

Method modifiers make a great fit with Roles to define
behaviors at a fine-grained level. Let’s take a look at another
example of a Role for our MyApp::Rifle class that makes use
of method modifiers:

package MyApp::MightJam;

use Moose::Role;

use Moose::Util::TypeConstraints;

requires 'fire';

subtype 'Probability' => (

as 'Num',

where { $_ >= 0 && $_ <= 1 },

message { "$_ is not a number between 0 and 1" }

);

has 'jam_probability' => ( 

is => 'ro', 

isa => 'Probability', 

default => .01 

);

sub roll_dice {

my $self = shift;

return 1 if ( rand(1) < $self->jam_probability );

return 0;

}

before 'fire' => sub {

my $self = shift;

die "Jammed!!!\n" if ($self->roll_dice);

};

1;

This Role adds the random chance of “Jamming” on any
given call to “fire” depending on the probability specified in the

INDEPTH

NOTE:
The semicolons at the end of the method modifier definitions in the

examples are required. Like all the keywords provided by Moose, 

the modifier sugar keywords actually are function calls and are not

subroutine definitions. The modifier definitions are all just function

calls with exactly two arguments: a string representing the name of

the method to modify and a code reference to the actual modifier.

CodeRefs are just treated syntactically as values like any other. It’s

not important to understand this fully to use method modifiers, but it

is important to remember to use the semicolons.
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jam_probability attribute (with the default probability set to 1%). I
also illustrate here how to create a custom subtype, by defining a
new type “Probability”, which must be a number between 0 and 1.

You then could compose simple subclasses like the following:

package MyApp::CrappyRifle;

use strict;

use Moose;

extends 'MyApp::AutomaticRifle';

with 'MyApp::MightJam';

has '+jam_probability' => ( default => .5 );

1;

And:

package MyApp::NiceRifle;

use strict;

use Moose;

extends 'MyApp::AutomaticRifle';

with 'MyApp::MightJam';

has '+jam_probability' => ( default => .001 );

1;

The difference between these two is that CrappyRifle will
jam on average 5 out 10 times, and NiceRifle will only jam 1
per 1,000 times.

Learning More
This article is just meant as an introduction to Moose, and because
of space constraints, I have been able to cover only a few of its
core features.

One of the other great things about Moose, and Perl in
general, is the community and availability of documentation and
resources. The Moose Manual, available on CPAN (see Resources),
is well-written and comprehensive. There are also plenty of other
docs and information available, and the number of them is grow-
ing every day as Moose continues to gain popularity.

If you get stuck on something and can’t find the answer, try
the #moose IRC channel on irc.perl.org. Many of the top experts
are in this channel and are more than willing to help and answer
questions. Although they will expect you to RTFM and have done
your homework first, they will get you unstuck and pointed in the
right direction.

If nothing else, I hope that this article has at least piqued your
interest in modern development with Perl and Moose, and that
you can see that Perl code can, in fact, be clean, easy to read and
modern, while still being “Perlish” and powerful.

As you learn Moose, and modern Perl in general, be sure
to check out some of the other projects and modules that are
available, including Catalyst, Template::Toolkit, DBIx::Class,
Try::Tiny, Test::More and Devel::NYTProf, just to name a few.
You might be surprised what’s out there, and what is really
possible with Perl today.�

Henry Van Styn is the founder of IntelliTree Solutions, an IT consulting and software development
firm located in Cincinnati, Ohio. Henry has been developing software and solutions for more than
ten years, ranging from sophisticated Web applications to low-level network and system utilities.
He is the author of Strong Branch Linux, an in-house server distribution based on Gentoo. Henry
can be contacted at www.intellitree.com.

Resources

Moose CPAN Page: search.cpan.org/perldoc?Moose

Moose Manual: search.cpan.org/perldoc?Moose::Manual

Moose::Util::TypeConstraints Documentation:
search.cpan.org/perldoc?Moose::Util::TypeConstraints

Moose IRC Channel: #moose on irc.perl.org

perlreftut—Perl Reference Tutorial: 
perldoc.perl.org/perlreftut.html
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As much as I love working with Linux and config-
uring software, one major part of being a sysadmin
that always has appealed to me is working with
actual hardware. There’s something about working
with tangible, physical servers that gives my job an
extra dimension and grounds it from what might
otherwise be a completely abstract job even further
disconnected from reality. On top of all that, when
you get a large shipment of servers, and you view
the servers at your company as your servers, there is
a similar anticipation and excitement when you
open a server box as when you open Christmas 
presents at home.

This story so happens to start during the
Christmas season. We had just received our first
shipment of a completely new blade infrastructure
that we were really excited to try out. As the 

resident server monkey and general minion working
under Bill’s iron fist, I was to meet up with an engi-
neer from our vendor at the data center and assist
with the installation in any way I could. It was a 
big job—two completely populated blade chassis
comprising 32 blade servers, integrated SAN switches
and all the assorted power supplies and network
pass-throughs that went along with it. We budgeted
a full day of the engineer’s time to rack the new
chassis, slot the blades and make sure all hardware
was functional and up to date.

[Bill: Iron fist? I like the sound of that. Reminds
me of a mid-1970s Marvel Superhero...but I digress.
I remember this occasion. We’d just finished piloting
a VMware/Blade infrastructure at our corporate office,
and we were about to roll it out to our production
data center, on next-generation hardware. It was 
an exciting time!]

I arrived at the data center a few hours before
the engineer so I could get all the boxes from shipping

and receiving and move them into our cage. If you
ever have ordered a blade chassis, you know that
everything arrives in these gigantic cardboard boxes
that incidentally were about the size of our shared
cubicle space back at the office. These boxes open
up to smaller boxes for the blade servers, chassis,
power supplies and the rest. At first things moved
smoothly. I broke down the first set of boxes, and
after a number of trips, the empty blade chassis
and the blades themselves were stacked neatly near
our cage.

The Jack in the Box
It wasn’t until I opened the last box that I realized I
was in trouble. Instead of containing a dozen large
boxes and mostly empty space, this box looked like
a failed game of Tetris. It was filled to the brim with

hundreds of tiny boxes of all shapes and sizes. The
engineer was going to be there soon, so I tried to
organize the boxes into different piles and then
filled my pushcart with swaying stacks of tiny 
boxes and made trip after trip to the colocation
cage until all of its walls looked like the inside of 
a brown-brick house.

[Bill: I seem to remember you sent a couple e-mails
to me along the lines of “Wow, this new stuff sure has
a lot of boxes compared to the old stuff.”]

This is probably a good point in the story to tell
you that up to this time, we normally had taken
advantage of our vendor’s integration service. We
standardized on servers with a certain amount of
RAM, CPU revision, storage and network configura-
tion that deviated from the base model, so our 
vendor would take the base order model and do
the work to add CPUs, RAM and the extra parts 
we wanted so that when we got a server, we could
just rack it and turn it on.

Unboxing Day
It’s Christmas time, and Kyle is about to open his new present: a
large shipment of blade servers. Find out about the extra present
his vendor left him.KYLE RANKIN

BILL CHILDERS

TALES FROM
THE SERVER ROOM

There’s something about working with tangible, physical
servers that gives my job an extra dimension and grounds
it from what might otherwise be a completely abstract job

even further disconnected from reality.
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In this case, for some reason, we failed to
request this integration service, so not only was 
I looking at the boxes for blades, chassis and 
power supplies, I had hard drives, CPUs, RAM, 
fiber-channel HBAs, extra NICs and even battery-
backed write caches all individually wrapped in 
their own boxes. Instead of unboxing a blade and
sliding it into its slot to install it, every single blade
would need to be opened, and then each and every
component would have to be opened, removed
from its static wrap, and installed into the blade
one by one.

[Bill: I have to say here that up until this point,
the vendor always had “thrown in” the integration
service for us, and it’s something we (and by we, I
mean me) had taken for granted...until the day my
boss called the vendor and deleted this “superfluous
service” from the quote, without telling me.]

Drowning in Cardboard
When the engineer arrived, I explained the situation,
and we both realized we had a long day ahead of

us. At the beginning, we made great progress. He
opened up and racked the chassis and power sup-
plies until the point that we were ready to install
the first blade server. At that point, we agreed on
an assembly-line system where he would open up a
blade, and I, like a surgical assistant, would unwrap
and hand him each component in a certain order so
he could install it. Then, while he finished up the
blade, I would fill up the cart with empty wrappers
and boxes and roll it to the trash area, so we didn’t
drown in anti-static wrap and cardboard. After a
full-day’s work, we were able to integrate 20 out of
our 32 blades successfully.

Unfortunately, we had booked the engineer only
for one day, but he was able to shuffle appoint-
ments around and return on Friday morning of that
week to finish up. Halfway through Friday morning,
we were able to finish with the blade servers so
that they all were racked. We were ready to be
done at that point, but we were only halfway there.
We still had to install all the hard drives, integrated
network pass-throughs, fiber-channel switches and
finally, upgrade the firmware.

[Bill: I had forgotten how long that job took.
Now that you mention it though, there was an
amazing amount of cardboard generated from 
that. It didn’t help that the data center didn’t allow

cardboard on the data center floor, and you had to
shuttle all that stuff back and forth.]

Late for the Party
Once we powered on the blades, it looked like we
were close to the finish line. I started packing up 
all my things so I could head home early and get
dressed up for our company’s big Christmas party
later that evening. Naturally, it was at this point
that a few of the blades wouldn’t power on. After
minimal troubleshooting, we were left with just one
misbehaving blade. The engineer started the hard-
ware troubleshooting process as I watched the min-
utes tick by. I realized I had to somehow power
through Bay Area traffic, get home, put on my suit
and drive back through the traffic to the party, and
rush hour was rapidly approaching. Ultimately, we
had to open up the server, remove all of the hardware
we had added only hours before, and insert the
hardware one piece at a time until we identified a
faulty DIMM slot. Finally, we were done and I was
able to get to the party fashionably late.

I think the moral to this story is pretty clear. If
we had only gotten all of our servers integrated
ahead of time, the entire install would have taken 
a fraction of the time, and any hardware problems
in the system would have been identified before
anything was shipped to me. When you have the
option, especially when it comes to large orders of
servers, get all your components integrated ahead
of time.

[Bill: The moral for me as a manager, is always
to double-check the quote for services, and make
sure that all of those are understood so they don’t
get labeled as non-essential and cut by people higher
up the food chain. I’m usually not a fan of too
many vendor services, but getting the entire system
integrated by a vendor will accelerate deployment
time by at least a couple days.]�

Kyle Rankin is a Sr. Systems Administrator in the San Francisco Bay Area
and the author of a number of books, including The Official Ubuntu Server
Book, Knoppix Hacks and Ubuntu Hacks. He is currently the president of the
North Bay Linux Users’ Group.

Bill Childers is an IT Manager in Silicon Valley, where he lives with his wife
and two children. He enjoys Linux far too much, and he probably should get
more sun from time to time. In his spare time, he does work with the Gilroy
Garlic Festival, but he does not smell like garlic.

TALES FROM THE SERVER ROOM

Instead of containing a dozen large boxes and mostly empty
space, this box looked like a failed game of Tetris.
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While searches for linux go down, success for Linux goes up. DOC SEARLS

Searches for the word “linux” have been
trending downward since early 2004,
according to Google (at www.google.com/
trends). Searches in mid-2011 are about
a quarter of what they were in early
2004. On the other hand, searches for
“android” more than doubled those for
“linux” by mid-2011. So, what should
we make of that?

Android is Linux-based, created by
Google for use in smartphones and other
mobile devices. According to Nielsen
(blog.nielsen.com/nielsenwire/consumer/
android-leads-u-s-in-smartphone-market-
share-and-data-usage), Android by
March 2011 was the top smartphone OS,
with a 36% market share. That’s up from
zero just several years ago. Apple’s iOS is
#2 with 33%, and RIM’s BlackBerryOS is
third with 23%. But only Apple makes
iOS-based devices, and only RIM makes
BlackBerries. There’s no limit on how many
companies can make an Android device,
which will only make the market wider.

There are downsides with Android. A
number of developers have told me the
Apple development environment is much
easier to work with, as is having a single
target device. Yet even in “How Apple
Feeds Its Army of App Makers” (in the
June 8 issue of Bloomberg Businessweek,
www.businessweek.com/magazine/
content/11_25/b4233039336374.htm),
Peter Burrows writes, “Apple hasn’t
monopolized developers’ attention.
According to a survey by market research
firm Evans Data, the percentage of develop-
ers writing apps for Android (43.5%) just
passed the share working in iOS (39.7%).”
(And there’s the fact that Android’s devel-
opment community is essentially a Google
one. This may change, but for now
Android is a one-company Linux distro.)

But the larger point holds: uses of
Linux only go up, even as searches for
the word “linux” go down. Hey, success
can get boring.

We see a similar thing happening with
Apache. Netcraft.com has been keeping
statistics on Web servers since August
1995, and Apache has been the top dog
ever since early 1996. While Microsoft Web

servers have been competitive for much
of that time, and even made some runs
against Apache, the trend for Apache
has been upward since early last year
(news.netcraft.com/archives/2011/06/07/
june-2011-web-server-survey.html#more-
4621). As of June 2011, Apache had a
64.88% share of the market.

Netcraft’s list of Most Reliable Hosting
Company Sites for May of this year also
was nearly a clean sweep for open source
as well, and for Linux in particular
(uptime.netcraft.com/perf/reports/
performance/Hosters?orderby=
epercent&tn=may_2011). Four of the
top ten were FreeBSD, five were Linux 
and one was F5 Big-IP. Of the top 50, five
were Windows, the top coming in at #18.
All but one (“unknown”) of the rest were
Linux and FreeBSD. For years, Windows at
least made a showing in the top 10, but
clearly a tide has turned.

“Welcome to GandhiCon 4” was the
title of my column in the March 2003 issue
of Linux Journal (www.linuxjournal.com/
article/6755). It played on the famous
quote often attributed to Mohandas
Gandhi: “First they ignore you, then they
laugh at you, then they fight you, then you
win.” The win then was in servers. Now
Linux has been succeeding for so long, in so
many different kinds of devices and form
factors, that it hardly seems like a fight
anymore. Even the desktop, which I often 
predicted (incorrectly) that Linux would win,
finally looks like it might be within reach.

As I write this (in early June), Apple
has just announced iCloud—and in the
process, demoted its computers to remote
terminal status. Google has nothing to
lose and everything to gain by playing the
same cloud game. Its strategy for that
is Chromebooks, aimed straight at pain
points for both the educational and
enterprise business markets.

Chromebooks will run Chrome OS,
which is a dedicated version of the open-
source (and Linux-based) Chromium OS,
first released by Google in November
2009. Chromebooks have rental rates:
$20 and $28 per month, respectively, for
students and businesses. Laptops from

Acer and Samsung will price in the
$350–$500 range. They’ll run the Google
suite of applications and services, and will
be managed and updated by Google. This
is what Nicholas G. Carr (in The Big Switch)
calls “utility” computing, and it’s another
reason why searches for “linux” will con-
tinue going down while uses for Linux go
up. IT departments will have less to do.

Some other interesting facts worth
noting. For “linux” searches:

� The top ten regions don’t include the
US. The top seven are all in Asia.

� The top five cities are in China, Taiwan,
Japan and India.

� English falls ninth among the top ten
languages. Czech is first, followed 
by Russian, Chinese, Japanese and
Indonesian. Even Finish and Hungarian
are ahead of English.

For “android” searches:

� The top four regions are all in Asia.
In order they are Hong Kong, Taiwan,
South Korea and Singapore. Sweden is
next. The US is seventh.

� Among the top cities, the US gets
three of the top ten. Atlanta is fifth,
Los Angeles is seventh, and New York
is ninth.

� The top languages are Korean,
Indonesian, Swedish and English, in
that order.

Go to Google Trends to see how
things are changing now (that is, whenever
you read this). What you’ll see isn’t a story
of Linux’s decline in the world. Success is
established. All that changes are versions
of that success. And that number is going
up too.�

Doc Searls is Senior Editor of Linux Journal. He is also a 
fellow with the Berkman Center for Internet and Society at
Harvard University and the Center for Information Technology
and Society at UC Santa Barbara.

GandhiCon 4.x

EOF
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Looks like these guys are comfortable overpaying 
for enterprise storage.  Are You?

“Hewlett-Packard Co. agreed to buy 3Par Inc. for $2.35 billion” — Bloomberg.com

Above specific configurations obtained from the respective websites on Feb. 1, 2011. Intel, Intel Logo, Intel Inside, Intel Inside Logo, Pentium, Xeon, and Xeon Inside are
trademarks or registered trademarks of Intel Corporation or its subsidiaries in the United States and other countries. All trademarks are the property of their respective
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“EMC to Buy Isilon Systems Inc. for $2.25 Billion” — Wall Street Journal

“Dell to Buy Compellent for $960 Million” — CNBC

So what “benefit” will you see by this spending spree, other than higher costs?
The AberSAN Z-Series scalable unified storage platform, featuring the Intel® Xeon® processor 5600
series, brings the simplicity of network attached storage (NAS) to the SAN environment by utilizing
the innovative ZFS file system. The AberSAN Z20 is easily found starting under $20,000.

Who gives you the best bang for the buck?
3Par Compellent Isilon Aberdeen

InServ F200 Storage Center Series 30 NL-Series AberSAN Z20

Storage Scale-Out ✓ ✓ ✓ ✓

Thin Provisioning ✓ ✓ ✓ ✓

HA Clustering ✓ ✓ ✓ ✓

VMware® Ready Certified ✓ ✓ ✓ ✓

Async / Synchronous Replication ✓ ✓ ✓ ✓

iSCSI / Fibre Channel Target ✓ ✓ iSCSI Only ✓

Unlimited Snapshots x ✓ ✓ ✓

Native Unified Storage: NFS, CiFS x x ✓ ✓

Virtualized SAN x x x ✓

Deduplication x x x ✓

Native File System none none OneFS ZFS 128-bit
RAID Level Support 5 and 6 5 and 6 Up to N+4 5, 6 and Z

Raw Array Capacity (max) 128TB 1280TB 2304TB Unlimited
Warranty 3 Years 5 Years 3 Years 5 Years

Online Configurator with Pricing Not Available Not Available Not Available Available

http://www.aberdeeninc.com/lj038
http://www.aberdeeninc.com/abpoly/abterms.htm


Cut Execution Time by >50% 
with WhisperStation-GPU
Delivered ready to run new GPU-enabled applications:

WhisperStation with 4 Tesla Fermi GPUs

2U Twin2 Node with 4 Hot-Swap Motherboards
Each with 2 CPUs and 256 GB

1U Node with  
2 Tesla Fermi GPUs

OctoPuter™ 4U Server with up to  
8 GPUs and 144 GB memory

Microway’s Latest Servers for Dense Clustering

 4P, 1U nodes with 48 CPU cores, 512 GB and QDR InfiniBand
 2P, 1U nodes with 24 CPU cores, 2 Tesla GPUs and QDR InfiniBand
 2U Twin2 with 4 Hot-Swap MBs, each with 2 Processors + 256 GB
 1U S2050 servers with 4 Tesla Fermi GPUs

Microway Puts YOU on the Cutting Edge

Design your next custom configuration with techs who speak HPC.  
Rely on our integration expertise for complete and thorough testing 
of your workstations, turnkey clusters and servers. Whether you need 
Linux or Windows, CUDA or OpenCL, we’ve been resolving the 
complicated issues – so you don’t have to – since 1982.

Integrating the latest CPUs with NVIDIA Tesla Fermi GPUs, Microway’s 
WhisperStation-GPU delivers 2x-100x the performance of standard 
workstations. Providing explosive performance, yet quiet, it’s custom  
designed for the power hungry applications you use. Take advantage of 
existing GPU applications or enable high performance with CUDA C/C++, 
PGI CUDA FORTRAN, or OpenCL compute kernels.

Nvidia Quadro for state of the art professional graphics and visualization

  Ultra-quiet fans, strategically placed baffles, and internal sound-proofing

  Up to 24 cores with the newest Intel and AMD Processors, 128 GB 
memory, 80 PLUS® certified power supply, and eight hard drives

   Up to Four Tesla Fermi GPUs, each with: 448 cores, 6 GB GDDR5, 
1 TFLOP single and 515 GFLOP double precision performance

   New: Microway CL-IDE™  for OpenCL programming on CPUs and GPUs

GSA Schedule
Contract Number:
GS-35F-0431N

ANSYS Mechanical
Autodesk Moldflow
 Mathematica

Simulation

MATLAB
ACUSIM AcuSolve
Tech-X GPULib

3ds Max
Bunkspeed 
 Shot
Adobe CS5

Design

AMBER
GROMACS
NAMD, VMD
TeraChem

BioTech

Configure your next WhisperStation or Cluster today!
microway.com/quickquote or call 508-746-7341
Sign up for technical newsletters and special GPU promotions at microway.com/newsletter
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